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1.  Create a Molecule Spreadsheet Data Table to Explore 
Structure-Activity Relationships  

SARVisionTM allows you to load a list of molecules as SDF or CSV file (with SMILES 
code) and create a database of compounds and associated data including chemical 
descriptors such as molecular weight, polar surface area, and lipophilicity (clogP).   

In the main menu FILE-IMPORT (sdf.file or csv with SMILES codes) opens a browser 
that allows one to navigate and import a molecule file. You can import multiple sdf. or 
csv files into a SARVision project file and large files of compounds are possible.  
 
Molecules will appear in the left most column under the heading Structure. Any other 
associated data included in the file will appear as columns located to the right of the 
structure column.  Your data sheets used by SARVision must have the SMILES code in 
the 1st column and labeled as Structure for presentation as structures in column 1.  
 

 

• PANEL 1. Data Table. Right click on row headers, spreadsheet header tab, 
column header and cells to get context menus to modify objects. Click on any 
data cell to modify or add data. 

The data table is a fully functional Excel spreadsheet where columns can be changed 
by: 
 

• ascending of descending data values (double click the column header to sort) 

• columns can be hidden and reordered 
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• columns can be heat-mapped to highlight activity data.  

• Additional data can be added or calculated using the main menu->insert 
functionality 

• Adding a Column adds an empty column on the end of the spreadsheet that the 
user can type in data, comments, or other information.   

• Adding an Expression allows the user to mathematically transform another  
column; for example the log() function can be applied to another column to 
create a new one. 
 

 

Molecular Data Tables can be sorted, edited, heat-mapped and cells formatted to help 
identify trends in biological assay data.  

Under Data Table tab (right click)  you can export to Excel and/or Word for further data 
input or presentations of structure-activity data.   

Common Structural Cores:  The Basis of Biological and Chemical Properties  

In a Data Table, molecules are grouped by a common structural core termed a 
scaffold to create families of related molecules.  
 
In SARVision any number of scaffolds can be added for analysis; or scaffolds specific 
to this data set can be drawn by the user.  
 
By right clicking in the scaffold pane (panel to the left) options are given: 
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• right click->Identify scaffolds- automatically finds chemical scaffolds and lists 
them  

• right click->Add scaffold- draw your desired compound or scaffold 

• right click->Import scaffold-import a list of compounds to search a Data Table 
with 

 
  
Molecules in SARvision can be aligned and color coded relative to any scaffold by 
double clicking on the scaffold of interest. Additionally, clicking on scaffolds can 
generate other views such as R-Group tables and scaffold centered molecular pair 
tables. 
 

 

Molecules in a related series are clustered on scaffolds and their substructures. 
Additionally, you can Add a scaffold and double click on it to filter, color code and align 
molecules to the selected scaffold for easy analysis.  

Under main menu->tools are options to: 

• Calculate molecular properties including molecular weight, polar surface area, 
and lipophilicity constants.  These values are added as columns to the right side 
of the Data Table  

• Select a Diverse subset for screening in bioassays 

• Add Columns to the Data Table 

• Rearrange or Hide Columns  
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Filtering Data to Create Structure-Data Subsets 

A fully functional filter panel to create subsets of data based on textual or numeric data 
is located on the lower left, can be used to subset (or highlight) columns in the Data 
Table that a user defines as a range of properties. In the same way that scaffold subset 
molecules based on substructure, these range filters can subset molecules based on 
bioactivity or chemical properties. Note that scaffolds and filters can operate 
independently or additively on the spreadsheet. 

 

Filter data by scaffold substructure and/or data ranges to see only relevant molecules in 
the spreadsheet. 

 

 

 

 

 

 



 CHEMAPPS.com                        Non-Confidential White Paper 

                Altoris, Inc.        San Diego, California       Phone: 858.461.6130 

II. Creating Grids of Molecules with Data 

 

A molecule data grid is an efficient and compact way to visualize structure-activity data. 

Molecules can be  arranged in a checkerboard fashion in sequential cells from left to 
right and top to bottom with relevant data in columns describing each molecule.  
 
The Data grid can be subset by a scaffold by double clicking on a scaffold, and 
displaying and checking the data fields desired (right panel).  
 
The Data grid can be exported to Excel and Word to rapidly create reports (right click-
>Data Grid tab options). 
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A molecular Data Grid displays molecules and data in a compact form. 

In SARvision, select main menu->Insert->Data grid. To filter the molecule data grid 
table, double click on any scaffold substructure to apply a substructure filter. This will 
reorient the molecules that belong to this scaffold and color code them based on the 
scaffold structure.  The data displayed under each molecule can be selected by a check 
box in the table control on the right side. Right click on any column in the check box 
control to create a heat-map icon next to the values in the table. To export this view, 
right click on the Data Grid tab.  
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III. Build R-Group Tables to Analyze Structure-Activity 
Relationships 

 R-Group tables are built around a scaffold or chemical core common to a group of 
molecules under study. This type of table displays molecules broken down by 
substitution patterns around the common chemical moiety.  

This allows for in depth analysis of Structure Activity Relationships (SAR) between 
chemical substituent patterns at each position with respect to different activities 
displayed by the molecules. Data can be derived from any experimental technique or 
even derived from in silico methods such as molecular docking. 

In SARvision, once a set of molecules has been loaded into a molecule spreadsheet, 
an R-Group table can be added under the main menu->Insert->R-Group table. By 
double-clicking on a scaffold in the scaffold pane, R-Group analysis and deconvolution 
is performed to populate this new table.  

The common chemical moiety or scaffold is located on the top of the table. Positions on 
this scaffold where the molecules in the set vary are sequentially numbered R1, 
R2….Rn.  Under this scaffold are the columns labeled R1, R2,…Rn where the R-
Groups or chemical fragments associated with each molecule are shown as rows in the 
table.  

R-Group tables are built on demand by double clicking on any scaffold.  
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To optimize the table, columns can be hidden, heat-mapped and sorted.  To sort a 
column double click the header to sort the rows from ascending or descending values.  
Double clicking a column of R-Groups sorts the table by complexity of the R-Group.  

To heat-map a column, right click on the column header and create coloring scheme in 
the popup user interface. The applied coloring scheme can be stoplight and/or a 
gradient in nature. Finally, to show/hide/change the order of the columns, right click on 
the R-Group table tab and select Columns option. 

Predicted physicochemical properties can be calculated for the R-Group columns to 
compare activity to properties. Under main Menu->Tools->Calculate molecular 
properties, individual properties can be selected for calculation. These appear in the 
table and function as any other column in the R-Group table.  

There are a number of customizable features to improve the presentation of the R-
Group table.  

• Any R-Group structure in the R-Group table can be substituted with a name (on 
R-Group: right click->rename).  
 

• The user can rename (and reorder) R-Groups by simply re-drawing the scaffold 
(right click->edit) and adding R-Groups with numbers on them to the desired 
position on the scaffold in the Scaffold panel. 

Similar to the Data Table, R-group tables can be exported by right clicking on the R-
Group table tab and selecting Export, creating an Excel spreadsheet or Word file for 
further presentations.   
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IV. Build two-way R-Group tables to analyze Structure 
Activity Relationships 

Two-way R-Group tables are a great way to analyze and visualize R-Group substitution 
patterns. R-Group combinations that have not been tried are easily identified while 
patterns of R-Groups that lead to bioactivity can be highlighted.  
 

Two-way tables are slices through an N-dimensional chemical space where each 
dimension corresponds to one R-Group position in the R-Group table (R1, R2….Rn). In 
the two-way R-Group tables, R-Group structures from two positions on the scaffold (Rx 
and Ry) are displayed in the column headers and the row header respectively. Inside 
each of the table’s cells are a list of the molecules with data that contain these two 
substation patterns.  
 

Ideally, the table is heat-mapped to make bioactive groups of molecules stand out. 
Using a mouse fly over, individual molecule structures on each row in the cell can be 
viewed. Two-way R-Group tables can be created for each pair of R-Group positions in 
the R-Group table. An example is shown below. 

 

 

A two-way R-Group table highlights key features in R-Group space. 
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There are multiple two-way tables that can be built for a molecule set. Each represents 
a slice through N-dimensional R-Group space defined by a scaffold core. 

 

To construct a set of two-way R-Group tables: right click on the R-Group tab in the R-
Group table in SARvision and select Exports->SABRE.  Inside SABRE, under main 
menu->R-Groups->Build RxR tables, begin construction of all desired pairwise tables. 
In the first user interface, select the two-way tables to be built by selecting the check-
boxes that correspond to the desired R-Group positions. In the second user interface, 
select 1) data to appear inside the table cells, 2) the desired heat-map coloring for the 
cells, 3) the format for the data and 4) the data that should appear in the mouse fly 
overs. Note that the two-way R-Group tables can be modified and rebuilt using this 
Build RxR tables menu option as necessary. 
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Under the main menu are a series of dialogues that will build custom formatted two-way 
tables for SAR analysis. 

For each two-way R-Group table, there is a filter option on the right of the display. Using 
this filter, the molecules that populate the table can be filtered in or out of the display to 
help focus results onto relevant molecules.  For example, in the R1 x R2 table below, 
the filter can be used to select for only molecules to populate the table that have desired 
R-Group substitutions in R1, R2, R3…Rn positions. Irrelevant or uninteresting 
substitutions can be removed from analysis using this filter.  
 

 

The population of molecules in the two-way table can be filtered at any R-position to 
study only those with R-Groups that are relevant to the current analysis. 
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Note that under exports these two-way tables can be exported into Excel or Word. 
 

 

 

V. Explore Scaffold Centered Molecular Pairs to 
Understand Structure Activity Relationships 

 

Molecular pairs are molecules that differ at only a single position. Isolating structural 
changes in this way useful to study Structure Activity Relationships. 

 A molecular pair table is built by analyzing a group of molecules to identify all pairs of 
molecules that are otherwise identical except for a change at a single position that can 
change activity data. The result is to remove all possible confounding structural 
variables to unequivocally connect a single structural modification to a change in the 
observable bioactivity data.  

In SARvision, the molecular pair relevance problem is solved by building molecule 
pairs that are anchored to a scaffold of interest selected by the user. The user can build 
as many pairs for as many scaffolds as desired simply by adding a molecule pair table 
(Main menu->Insert->Substituent analysis) and selecting the relevant scaffolds one 
at a time (double clicking). The pair finding algorithm begins with a subset of 
molecules that belong to this scaffold and identifies molecular pairs that include this 
scaffold core.  The two pairs are shown side by side with structural differences denoted 
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by different colors. Below each structure is observable data measured for each 
molecule.  

The third column focuses on the change in structure (top) and data(bottom) for this 
molecular pair. Note that the change in data can be depicted as difference or a ratio 
(table control: right bottom: drop down). 

 

SARvision builds molecular pair tables centered on specific scaffolds. Pairs can be 
easily filtered by R-position to facilitate analysis. 

Often too many molecular pairs are derived for closely related sets of molecules and it 
is desirable to subset further by pairs that change at only specific positions. In the 
control panel (right) is a check box for each R-Group position (the R-Groups are the 
same as described in the R-Group table). Unchecking an R-Group temporarily removes 
it from the display allowing browsing of the data one scaffold R-position at a time. Note 
that molecular pairs are now filtered by a scaffold core and by position to make 
analyzing molecular pair changes easy to visualize. 

Sometimes a series may have two closely related cores and the user may want to 
identify pairs of molecules that have the same R-Groups but change at the core. Placing 
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these cores into a folder in the scaffold tree (scaffold pane:right click->Add folder, 
folder:right click->Add scaffold) and selecting the folder (folder: double click) 
creates a new molecular pair table. This is built listing only pairs where the cores listed 
in this folders are swapped. The table is otherwise identical to those created with a 
single scaffold. This can be useful for scaffold or core hopping exercises. 

 

Comparing scaffold cores or core-hopping is easily performed by using folders in the 
scaffold tree. 
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VI. Analyzing PROTAC Structure-Activity Relationships  

Performing Structure-Activity analysis on bi-ligands such as PROTACS requires 

software that can identify the linker and break the molecule into its constituent parts-the 

ligase modulator-Linker-and Targeting molecule segments. 

Medicinal chemists link the modulator to the targeting molecule together through a linker 

to achieve new and novel biological activities.   PROTAC molecules best exemplify this 

approach where an E3 ligase modulator is linked to a targeting warhead ligand that 

recruits a protein target for degradation.  SARVision allows the user to retro 

synthetically deconvolute these molecules into their constituent components to perform 

structure-activity analysis while providing insights into novel and bioactive chemical 

structures on a routine basis.  

 

 

A PROTAC linker analysis module has been added to SARvision to present chemically 

relevant linkers and to make SAR studies of bi-ligands routine and efficient to perform. 

The PROTAC functionality is designed to study not only PROTACs, but also is 

applicable to work on any set of molecules that possess two or more ligands joined by 

chemical linkers.  
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The algorithm identifies and deconstructs the molecules into a linker and the two ligands 

such that they can be readily analyzed and visualized using SAR tables created by 

SARvision.  

For PROTAC molecules, the E3 ligase modulator is identified and positioned on the left 

side. The linker is extended horizontally between the two ligands. The remaining moiety, the 

targeting warhead, is oriented to the right.  

 

Molecules in SDF or SMILES format can be easily imported into SARvision (file->import 

molecules : load SDF, Smiles). A set of molecules designed to degrade BCR-ABL can be 

loaded for study (download here). We are using a set obtained from PROTAC DB: Nucleic 

Acids Research, 2020. Doi: 10.1093/nar/gkaa807 for this example. 

Molecules and any associated data will appear in the molecule Data Table. Once the molecules 

have been loaded, click the Linker analysis button to perform the analysis. The algorithm 

processes the molecules and populates any open tables: Data Table, R-Group Table, Data 

Grid and Substituent Analysis table are the most relevant. This step identifies the linker 

highlighting it in red (default color), reorients the molecules such that the E3 ligase ligand is on 

the left and the target warhead is on the right. Rows can be sorted by any data column which in 

turn can be heat mapped by value as shown for DC50 (nM) below. 

 

 

 

 

https://www.chemapps.com/s/BCR-ABL.sdf
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VII. Finding Chemical Reagents and Molecules from 

Commercial Vendors 
 

Purchasing chemicals for organic synthesis, creating chemical series for assay, or 

generating chemical libraries for high throughput screening (HTS) can be a time and 

labor intensive process, as many manufacturers and  vendors for chemicals exist, and 

different vendor databases can be incomplete, have compounds listed but not available, 

and finding the proper compounds for research can be frustrating and unproductive.  

CHEMAPPS has addressed this need, and has several different proprietary chemical 

databases that contain vetted and qualified manufacturers and vendors of fine 

chemicals, pharmaceutical and agricultural chemicals, and biochemical and unique 

chemicals used routinely in the lab.   

The 245,960 compounds found at www.buymolecules.com are actual compounds from 

over 14 vendors, vetted and qualified, and are ready to ship to customers worldwide.   

http://www.buymolecules.com/
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The CHEMAPPS search page shows results for substructure searches of vendor and 
other online molecules. 

The Molecule Finder web tool organizes libraries of compounds in intuitive ways for chemists 

to browse and select molecules individually or in groups. The user can begin either with a 

Search using the molecule drawing tool or by browsing the Popular Scaffolds.  

On the Search page, the user can draw a scaffold to perform an exact/substructure search or 

enter a list of names or compound names to text search.  At the bottom of the page is the users’ 

history of previous searches that can be re-run by simply clicking on the scaffold. 
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Each scaffold is grouped by chemical type and can be clicked to perform a search 
against a library of molecules. 

The Results page is presented in three sections: 1) The scaffold currently being searched (top). 

2) Sub-scaffolds that are children (contain substructure) of the current search scaffold (middle). 

3) Molecules that belong to the current scaffold family (bottom). 
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Search page showing the selected scaffold (top), child scaffold families (middle) and 
molecule hits (bottom). Exact substructure matches are highlighted with blue squares. 
Below each molecule descriptive data is display such as the cas# in this case.  

Through out the program are buttons under molecules that preform operations on the 

cart. 

• Adds the molecules or in the case of a scaffold, the scaffold-family of molecules 
to the cart [+]. 

• Removes any molecules in the cart the belong to this scaffold-family (i.e. remove 
all molecules that have a carboxylic acids) [-]. 

• Performs a intersection with the cart with the current scaffold family. Cart will 
keep only molecules that are already in the cart and belong to the scaffold-family 
(i.e. remove all molecules that do not have a carboxylic acid) [opposing arrows]. 

• Clones the current search molecule and opens it in the editor to refine the search 
by modifying the scaffold structure [pencil]. 
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• Removes the current molecule from the cart or remove scaffold search from 
history [trash]. 

On the Cart page the user can display and edit a cart of molecules. There are four main 

functions:  

1) Request a price quote for the current set of molecules in the cart. Adding your 

username and email will send a quote directly to you.   

2) Filter the cart by physicochemical properties. 3) Adjust the quantity of desired 

material (in mg, default = 10g or 10000mg). 4) Clear the Cart of all molecules. 
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The cart contains collections of molecules created by the user. These display some 
relevant chemical information. 

 

 


